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Introduction

Introduction

Continuing our strong multi-platform commitment, we now
provide FirstClass for UNIX. FirstClass 7.1 for Mac OS X is our
first FirstClass system for UNIX. It offers all the same benefits
and dependability of FirstClass on Windows and classic Mac OS
environments.

About this book

This book is a supplement to the standard FirstClass
administrator’s guides and documentation set. Because
FirstClass works seamlessly across platforms, most of the
information you will need in order to use FirstClass on a Mac OS
X environment is available in those standard documents.

Although using FirstClass on Mac OS X is very much like using
FirstClass on any other platform, there are some differences in
the way FirstClass is installed and configured on the Mac OS X
platform, and the way a migration is handled. This book
provides extra information specific to installing and configuring
FirstClass in the Mac OS X environment.

This book tells you how to:

« install FirstClass on Mac OS X

This section provides requirements and instructions for
installing the various FirstClass components.

« start your server and log in

This section explains how to start and log into your FirstClass
system and what you will see on the administrator’s Desktop.

 configure your system on Mac OS X
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About this book

Who should read this
book

Whatyoushould already
know

Documentation
conventions

This section explains what the FirstClass installer configures
on your system and what you need to check and configure
after installation.

» migrate FirstClass from Mac OS 9 to Mac OS X

For those already using FirstClass on Mac OS 9, this section
explains how to migrate a 7.1 FirstClass post office from the
classic Mac OS environment to the Mac OS X environment.

« administrate FirstClass on Mac OS X.
This section provides some Mac OS X-specific information
helpful for the day-to-day operation of your FirstClass system.

There is also an appendix that describes file locations in Mac OS
X.

This book is intended for FirstClass administrators responsible
for setting up and maintaining a FirstClass system on Mac OS X,
whether new to FirstClass or migrating an existing FirstClass
system to the Mac OS X environment.

You should be familiar with the capabilities and terminology of
your:

» TFirstClass software (server, client, Internet Services, Voice
Services [if applicable], and additional components)

¢ Mac OS X operating system.

The following conventions are used in this guide:

e menu items

Each level of menu items is separated by >. For example, the
Clear item under the Edit menu is shown as Edit > Clear.

» variables

Text in italics represents variables for which you must type
your own value.

e script syntax.

Script syntax text is formatted | i ke t hi s to distinguish it
from other text.
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More information

For more conceptual information and details about FirstClass in
general, FirstClass Administrator’s Guide and Internet Services
Administrator’s Guide in our online help explain the procedures
involved in planning, creating and maintaining a FirstClass
server environment. These guides also provide a walkthrough of
a simple system for an example company that administrators
new to FirstClass will find very useful.
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Installing FirstClass

Installing FirstClass

You can install the FirstClass server and Internet Services on
separate machines, or together on a single computer with either
a single processor or multiple processors. The minimum
requirements for each scenario are listed below, but the actual
performance of your system will vary depending on how
powerful your hardware is and how busy your system gets.

If you install the FirstClass server and Internet Services on two
dissimilar machines, we generally suggest using the machine
with the more powerful processor to run Internet Services,
though that depends to a large extent on the primary use to
which your system will be put. If, for example, your system will
be used primarily as a web server, you will want Internet
Services on the more powerful machine. If, on the other hand,
your server will be under a heavy load of FirstClass users, then
you will want the server to be on the machine with the better
disk system.

System requirements for FirstClass server and Internet

Services

FirstClass server and
Internet Services
together

¢ Mac OS X, 10.2.3 or higher

+ 128 MB memory recommended, plus 250 KB for each
concurrent session

« additional memory required if you are mirroring volumes (see
“FirstClass server only” below)

« minimum 100 MB free disk space, plus additional storage for
mail and user data and temporary space required by the
installer
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FirstClass server only

Internet Services only

¢ Mac OS X, 10.2.3 or higher
e 128 MB memory recommended, plus 250 KB for each

concurrent session

* additional memory required if you are mirroring volumes

(amount of additional memory depends on the activity level
and the number of users simultaneously making changes
while synchronizing the mirror)

« minimum 90 MB free disk space, plus additional storage for

mail and user data

e Mac OS X, 10.2.3 or higher

* 64 MB memory recommended (and the more memory the

better)

+ 10 MB free disk space

Installing the FirstClass server and Internet Services

Before installing
FirstClass

Before you can install FirstClass you must create a user named
“fcadmin” and log into the operating system as this user. Create
the fcadmin user as follows:

1. Choose Apple menu > System Preferences > Accounts.

2. Click New User to open the New User form.

3. Type a long name and short name for the user.

The long name you choose doesn’t matter, but we
recommend (and this documentation will assume) the long
name FirstClass Administrator.

The short name must be fcadmin.

Caution If you don’t give the user exactly this short name,
you won’t be able to install FirstClass.

4. Type a password for the user.

You will be asked for this password to install FirstClass and
to perform other administrative duties.
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Installing FirstClass

5. Select “Allow user to administer this computer”.

Caution If you don’t do this you won’t have administrative
level permissions and won’t be able to install
FirstClass.

6. Log out of the current user account and log back in as
fcadmin.

During the installation you will be asked whether you want to
install the FirstClass server and whether you want to install
Internet Services. To install both on the same machine, accept
the default [yes] in both cases. To install the FirstClass server
and Internet Services on separate machines, repeat the
installation process on both machines, selecting only the
component you want to install on each machine.

The installer will attempt to determine appropriate default
settings for the System Profile and Internet configuration forms
to allow the FirstClass server and Internet Services to “just
work”. The installer will ask you to confirm these defaults during
the installation. After installation, you should review these
forms and verify that they do not need to be changed.

The installer will also ask you whether you want the server and
Internet Services to autostart on a machine restart. By default,
these programs will be running in the background after a reboot
even if no user is logged into Mac OS X yet.

Note You can also disable the server or Internet Services
autostarts manually after installation by removing
the FirstClass Server and/or FirstClass Internet
Services folders from Startupltems in the /Library
folder.

Install FirstClass as follows:

1. If you received the installer as a .dmg file
Double-click the .dmg file to expand it.

If you are installing from a CD
Skip to Step 2.
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System requirements for FirstClass client on Mac OS X

2. Double-click “Install FirstClass Server.command” to start the
installer script.

3. Respond to the prompts. In many cases, you need only hit
<Enter> to confirm the default responses.

4. Restart the Mac OS X machine at the end of the installation
process, if you chose to autostart either the server, or
Internet Services, or manually start the server and Internet
Services from the Desktop icons created by the installer.

Note If existing HTTP or FTP services are enabled on the
Internet Services machine, Internet Services will fail
to open the reserved IP ports. To disable the
conflicting services, choose Apple menu > System
Preferences > Sharing and clear these services.

Licensing FirstClass After you install the FirstClass server, you can add optional
licenses, such as user licenses. To do this, use the FirstClass
Tools application. This application is described in FirstClass
Tools Reference in our online help.

Note The FirstClass Tools application on Mac OS X does
not accept license diskettes. Only license files can be
used in the Mac OS X environment.

Tip We suggest that you license your server before
configuring FirstClass. To configure FirstClass, you
must log in as the administrator, and the first time
you do this, you will be asked for licensing
information in order to register.

System requirements for FirstClass client on Mac OS X
e Mac OS X, 10.1 or higher
* minimum 64 MB available RAM

« minimum 6 MB free disk space
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Installing the FirstClass client

To install the FirstClass client software, insert the FirstClass
installation CD or download the installer from our web site and
follow the instructions.

When you install or upgrade to FirstClass 7, a ClientDownloads
folder will be created within the Internet Services > WWW
folder. Inside this folder are links to the client installers and the
readme documents.

If you have a company home page created, the home page
document in the WWW folder inside the Internet Services folder
can also be used by users to link to the downloads page on our
web site and download the client.

Once the client is installed, for the initial login, users should
click the login link on the home page to log in. An X-FC tag will
update the home.fc settings file with the Domain name from the
System Profile. Once the domain name is added to the home.fc
settings file, users will be able to connect to your server without
further configuration. Users do not need to know the server IP
address to connect.

For more information about the FirstClass client, see our online
help or A Business Professional’s Guide to FirstClass.

The FirstClass Server folder

The FirstClass server and Internet Services files are stored in a
FirstClass Server folder within the /Library folder. Before
logging into your FirstClass system and beginning to use it, you
may want to familiarize yourself with the contents of the
FirstClass Server folder. Instructions for accessing and using
these files follow in the remaining chapters of this guide.

The FirstClass Server folder contains the server and FirstClass
Tools applications, as well as supporting files. If you installed
Internet Services on the same machine as the FirstClass server,
the Internet Services files will also be in the folder. Otherwise,
they will be in the corresponding FirstClass Server folder on the
Internet Services machine.
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The FirstClass Server folder

This folder contains the following folders and files:

o fesd

The FirstClass core server executable.

o fesd.rez

The FirstClass server resources.

» fctools

The FirstClass Tools application. You use FirstClass Tools to
license and configure your server, and to configure sessions.
For more information about FirstClass Tools, see FirstClass
Tools Reference in our online help.

« FirstClass Server Start.command/FirstClass Server
Stop.command

Commands that activate control scripts to start and stop the
FirstClass server.

+ .log/.old files

Log files that are generated every time you start the server or
Internet Services. The .log files contain detailed log entries
from the latest run, and the .old files contain the output of the
previous run. Because these files recycle every time you start
the server, you lose the information after two restarts. Similar
information is stored permanently, though, in the server logs
under /Library/FirstClass Server/Volumes/Master/fcpo/
logfiles.

Note If you have had previous experience with FirstClass
on a Windows or classic Mac OS, you will be used
to seeing the information that is recorded in these
log files in the server console of FirstClass.

 Status of FirstClass Services.command

A command file that activates a control script that provides
you with the status of the FirstClass server and Internet
Services.

e Volumes.

A folder in which you can define an explicit list of logical
FirstClass volumes accessible to the server. These need not
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correspond directly to physical drives, but could also be
folders or symbolic links to any location visible in the Mac OS
X file system hierarchy. For this reason, they are referred to as
logical volumes. For more information about FirstClass logical
volumes and their uses, see Using FirstClass volumes in the
Administrating FirstClass chapter of this guide.

 fefixvol

A utility you use to properly set the initial permissions on the
files and folders in a FirstClass post office after you copy the
post office from one volume to another or restore from a
backup. For the purpose of migration, this includes another
utility (fclower.pl) that converts all post office file names to
lowercase for use in the Mac OS X file system.

Internet Services folders  The following folders and files are also in the FirstClass Server
and files folder if you installed Internet Services on this machine:

« fcisd

The FirstClass Internet Services executable.
« fcisd.rez

The Internet Services resources.
« fcp

A folder containing FCP network protocol definition files. FCP
is the protocol used to communicate between the FirstClass
client or services modules and the FirstClass server.

* config

A folder containing configuration files for Internet Services.

* inetsvcs.fc

The settings file for Internet Services. This is preconfigured
for 127.0.0.1 by default for systems with the FirstClass server
and Internet Services on a single machine. If the FirstClass
server and Internet Services are on two separate machines,
this must be updated with the server’s IP address or name. See
Configuring the inetsvcs.fc file for more information.

« Internet Services Start.command/Internet Services
Stop.command.
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The FirstClass Server folder

Commands that activate control scripts to start and stop
Internet Services.
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Starting your server and logging in

Starting your server and logging in

In order to do any system administration, whether from the
server level or from the client, the server must be running. You
will perform most administrative functions when you are logged
into the client as the administrator.

Starting your server

By default, the Mac OS X installer configures the server and
Internet Services to autostart on system restart. These programs
will be running in the background after a reboot even if no user
is logged into Mac OS X yet. You can also start the server
manually.

The FirstClass server application resides in the /Library folder in
a FirstClass folder. It is called fesd (FirstClass server daemon).
You can start fesd directly but we suggest you use the FirstClass
Server Start alias on the Mac OS X desktop. There are aliases on
the desktop for all of the following commands:

* FirstClass Server Start
+ FirstClass Server Stop
* FirstClass Tools

* Internet Services Start
¢ Internet Services Stop

« Status of FirstClass Services.

You can also start, stop and check the execution status of the
server and Internet Services manually with the provided shell
scripts as follows:

1. Choose Go > Applications.
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Logging in as the FirstClass administrator

2. Double-click the Terminal application in the Utilities folder.

3. Type one of the commands below and press Enter.

If prompted for a password, enter the fcadmin user’s
password.

Possible commands:
e fcsctl start starts the server
« fcsctl stop stops the server
« fcsctl status checks server status
e fcisctl start starts Internet Services
o fcisctl stop stops Internet Services
« fcisctl status checks Internet Services status.

Note Only the root user or machine administrators can
start or stop the server or Internet Services. No
matter who launches these programs, they will start
up under the root user and admin group and will
then fall back to the real context of the user who
launched them, switching back to root-equivalent
access only while opening reserved IP ports.
Currently, only one user, fcadmin, is supported, so

manually start the server and Internet Services only
from that account.

Logging in as the FirstClass administrator

The FirstClass installation application adds a special user
account for the FirstClass administrator:

* the user ID is admin
+ the password is admin

* the name is Administrator.

Note To preserve the security of your FirstClass system,
you should change the password for the
administrator account the first time you log in by
choosing Collaborate > Change Password. Keep the
new password confidential. We recommend that
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you not save the administrator’s password in your
settings file.

Warning You can change the name, password, and user ID
associated with the administrator account, but
never delete this account. If you do, you won’t be
able to log in as the administrator, and you will
have to reinstall your server.

While you can log into the administrator account using a web
browser, you must use a FirstClass client to perform all
administrative tasks.

Registering your server and licenses

When you log in as administrator for the first time, the FCS
Registration form will open.

You must complete and send this form to get access to online
software and documentation updates and be allowed to post
support questions to our customer conferences. Some of the
fields will already be filled in for you. A copy of this form will be
left on the administrator’s Desktop for your reference.

After your registration has been received, you will be sent
information about accessing our own server and given access to
customer conferences.

The administrator’s Desktop

In addition to the standard objects that all users see, the
administrator's Desktop contains its own set of standard objects.

Your administrator’s Desktop (Business Edition) looks like this:
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The administrator’s Desktop

The administrator's Desktop
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Do not delete or rename any objects on the administrator’s
Desktop. If you do, you might not be able to perform necessary
administrative tasks. These objects are protected from deletion
by default.

Warning If you delete one of the standard user icons from
your administrator's Desktop, that object and all its
contents will be deleted and it may be impossible to
restore the administrator's link. You can recover it,
by choosing View > Show Deleted Items and using
the undelete feature, only until trash collection
runs.

e Start Here folder

A folder containing inportant information about setting up
and configuring your FirstClass system.
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Mailbox

The administrator’s Mailbox where system messages are
automatically sent. We suggest you create a personal user
account for non-administrative duties and personal email.
This will also keep your personal information out of the
administrator’s address book and calendar.

Address Book

The address book for the administrator’s account, for use in
sending messages in your official capacity as administrator.

FCS Registration form

The online registration form you must complete and send to
get access to product and documentation updates and support
conferences.

Calendar
The calendar for the administrator’s account, if required.
Note This object is not automatically created. Choose File

> Open > Calendar to add this calendar to the
administrator’s Desktop.

Groups

A folder containing all the user and conference groups defined
on your server.

General Conferences

A folder in which you can add conferences to allow users to
collaborate effectively. These conferences are only visible to
users when you subscribe the users to a conference, add a
conference to a user group’s Model Desktop, or put a link to a
conference in a public place.

Mail Lists

A folder containing all the public mail lists on your server.

Monitors

A folder containing the Server Monitor, Session Monitor and
Internet Monitor.

Reports
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A folder containing Statistics and Log Files folders, and the
Statistics Control form. For more information about the
statistics and log files contained in these folders, see the
FirstClass Administrator’s Guide and our online help.

Hard Disk

An external folder that gives you access to the files on the
Firstlcass volume containing the primary post office.

Internet Services

A folder in which you configure your Internet connections and
services.

Volumes

Folders containing the root volume and logical FirstClass
Server volumes. For more information about logical FirstClass
volumes, see Using FirstClass volumes in the Administrating
FirstClass chapter of this guide.

FC Resource Registry

A folder which allows you to store resources such as forms,
icons and sounds on the server for all your users to access.

Gateways

A folder containing the gateways defined on your server.

Help

A folder containing our online help. You can add your own
folder of help information to this folder if your users require
additional online help material for your system setup.

The administrator’s help (Admin Help) is only accessible from
the administrator’s Desktop, and by users in the Sub Admin
and Webmasters groups. This help is also available from the
Help menu.

CLUI Help

A folder containing the Command Line User Interface (CLUI)
online help.

Multi-Site Setup
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A folder containing forms used in setting up networks
consisting of two or more servers, using the Directory
synchronization feature.

» MultiVol Conferences

Folders containing lists of all the full-use secondary volumes.
This is useful for creating content that is physically located on
a different volume.

The client’s Control The Control menu on the administrator’s Desktop provides you

menu with menu options for some of the most common server and
Internet Services control tasks. These tasks are described further
in FirstClass Administrator’s Guide and our online help. Choose
Admin > Control to access this menu. The following information
describes these menu items and their functions:

Trash Collection Causes immediate trash collection.

Fast Shutdown  Forces off all users and shuts down the server
immediately. Other than the abrupt disconnect
logged-in users will see, this should be
considered safe at all times.

Polite Shutdown Sends a message to users warning them and
waits for them to log off before shutting down
the server.

Restart Not available on OS X.
Logoff AllUsers  Disconnects all users without shutting down.
Logoff Selected Disconnects selected users without shutting

Users down.
Reset Server Not used on the OS X server.
Modems

Pause Mirroring Pauses server mirroring immediately.

Continue Resumes paused server mirroring.
Mirroring
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Configuring your system on Mac OS X

The FirstClass Mac OS X installer auto configures as much as
possible, so that the FirstClass server and Internet Services just
work immediately after running the installer. To do this, the
installer tries to determine appropriate default settings for your
System Profile and Internet configuration forms and asks you to
confirm or alter those defaults during installation. In order to
complete the configuration of your system, you should review
those default values and adjust them for your individual
situation as required.

Configuring the System Profile

System Profile Server
tab

To configure your system you must complete the System Profile
form. For a complete explanation of all fields on this form, see
our online help.

Note You must log in as the FirstClass administrator
using the FirstClass client in order to configure your
system.

To access the System Profile, select Admin > System Profile
from the administrator’s Desktop.The default settings provided
on this form are meant to meet the needs of the majority of
users.

This tab contains basic system information.

Complete this form as follows:

Network name This is not used on the OS X server.
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Site name

Domain name

Server priority

Minimum free disk
space

This identifies you to any FirstClass servers
you may establish gateways with and you
see it on the client’s windows and on the
server monitor’s summary tab. The installer
will attempt to determine an appropriate
value for this field, based on the machine’s
node name, but you should check this value
after the installation and change it to
something more suitable if required. For
more information about gateways, see
FirstClass Administrator’s Guide.

This is your registered domain name and
defaults to the domain name known to the
operating system at installation time. If
there is no domain name configured, the
FirstClass server installer will use the IP
address of the computer you have your
FirstClass server installed on. As with the
site name, the installer will attempt to
determine an appropriate value for this
field, but you should check this value after
the installation and change it to something
more suitable if required.

This sets the priority of server operations on
the machine.You should always leave this
set to the default value of Medium.

This sets the minimum level of available disk
space. When the available disk space on a
FirstClass volume falls below this level, that
volume will go into “write protect mode”,
and basic tasks, like creating new messages,
will not be allowed by the server. The
default value, 1000 KB, is low enough that it
won’t often be reached, but high enough to
allow some maneuvering room on the
volume.

Your optimal setting will depend on your
hardware configuration.
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Disable all logins This allows you to perform administrative
functions while no users are logged in (for
example, major changes to user groups,
permissions, or directories).You must
remember to clear this or restart the server
when you have finished. Because most
administrative functions can be performed
with users logged in, you won'’t likely be
using this feature frequently.

For now, then, leave this unchecked.

Time zone This is the local time zone of your FirstClass
server. This field is not filled in by the
installer. You must complete it manually.
This should be the same as the time zone
selected in the Mac OS X System Preferences
> Date & Time > Time Zone.

System Profile Timers On this tab, you set rules about deletion and disconnecting
tab
users.

Complete this form as follows:

Private mail expiry This sets the length of time before private
mail expires from users’ mailboxes. The
default 60 day value is intended to be long
enough that valuable mail won’t be quickly
lost and short enough that mailboxes won’t
be overloaded. Your setting should reflect
the usefulness of old mail on your system
and the amount of disk space you have
available. You can set mail expiry also for
individual users or user groups, and you can
allow users to change the expiry period of
individual messages. See FirstClass
Administrator’s Guide.
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Conference item
expiry

Trash collection
time

Last collection

Logoff warning

This sets the default time an item will stay in
a conference before expiring. The default
value is 120 days. This number should reflect
the importance of old mail in conferences
and the amount of disk space you have
available. The expiry period can be
overridden for individual conferences and
conference groups. See FirstClass
Administrator’s Guide for more information.

This sets the time that trash collection will
take place. The default trash collection time
is set as 3:00 AM, because people aren’t
normally working at that time. Although the
server continues to function during trash
collection, it’s best to schedule it when use is
minimal.

This is the date and time of the most recent
trash collection.

This sets the time between a logoff warning

interval and the actual logoff. The default is set as 30
seconds. The server issues warning messages
when a user’s time limit is about to expire, or
if a user is inactive. For more information,
see our online help.

Modem login This is not used on OS X.

timeout

System Profile Usage On this tab, you enter settings that will affect users in their day-
Limits tab to-day system use.

Complete this form as follows:

Daily connection limit This sets the maximum daily connection

time for each user. The default is set for
the maximum 1440 minutes so that
employees have continual access. You can
limit specific users’ access elsewhere. See
FirstClass Administrator’s Guide for more
information.
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Inactivity limit before This sets the maximum time per session
logoff that a user can be inactive before being
logged off. The default is set at 5 minutes.

Inactivity limit before This sets the maximum time a user’s

deletion account can be inactive (not connected to
a server) before being deleted. The default
value for this is “No Limit” to support
scenarios such as customers who might
only log in a few times a year and
employees who take extended leave.

FirstClass Notifier This sets the maximum number of users

limit who can enable FirstClass Notifier. The
default value is 50 but you might want to
increase it if you have a large number of
machines configured to receive
notifications. There is only a very small
memory cost to increasing this. For more
information, see our online help.

Login limitperuser  This sets the maximum number of sessions
a user can have open at once using the
same user ID. The default is “No Limit”.
FirstClass supports multiple logins to the
same account.

System Profile Userstab  On this tab, you make decisions about how users can access the
system and where their data is stored.
Complete this form as follows:

Create users and This identifies the FirstClass volume on
conferences onvolume which you want to add new users and
conferences. The default is Master.
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Require unique user
names

Remote
autoregistration

Network
autoregistration

Autoregister
notification

Guest access

This prevents the creation of user
accounts and conferences with duplicate
names and is recommended because
duplicate user names can create
confusion and will make it difficult to use
automatically-generated Internet alias
options. For more information, see
FirstClass Internet Services Administrator’s
Guide.

If you are using organizational units and
want to permit multiple users with the
same name (as long as they are in
separate organizational units), clear this
check box. For information about
organizational units, see FirstClass
Administrator’s Guide

This allows users who connect using
remote sessions to register when they log
in. The default is not to allow this because
it makes it possible for anyone who can
connect to your system to create their
own account and possibly annoy other
users.

This allows users who connect over a LAN
to register when they log in. As with
remote registration, the default is not to
allow this because it takes away your
control over who is registered.

This notifies the administrator when a
user auto registers. This has no effect if
you do not allow auto registration.

This allows people to log in as guest
users. It is cleared by default, but you
might want to select it to allow
unregistered users to log in and request
an account, giving you more control over
registrations.
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Guest user ID This can be any valid ID. We suggest
Guest because it is descriptive and easy to
remember.You can create a special
Desktop for this user ID, with the
information you feel guest users need.

Command lineaccess  This allows users to access the server
using a network tool such as telnet. This
is an advanced feature and it is not
enabled by default.

System Profile Other On this tab, you make decisions about security and disk space.
Defaults tab

Complete this form as follows:

Secure all Desktops  This prevents the administrator and sub
administrators from viewing other users’
Desktops. It is not enabled by default.

Allow blank password  This lets users leave password fields blank
field and is not selected by default because this
is a security risk.

Suppress conference  This prevents the collection of some

history history information for conference and
calendar items and is not enabled by
default because History is a valuable
feature and the disk space impact is
minimal.

Suppress conference  This turns off receipt notification for

receipt notification ~ messages sent to conferences and is not
selected by default because, again, thisis a
valuable feature and the disk space impact
is minimal.

Configuring the Basic Internet Setup form

As it does with the server, the FirstClass installer for OS X will
auto-configure Internet Services as much as possible for you, so
that it just works, but you need to review the default values
provided by the installer and adjust them and/or add to them for
your individual situation as required.
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General tab

Connection tab

You should review the Basic Internet Setup form to select the
various Internet protocols on your system. For a complete
explanation of all fields on this form, see our online help.

The Basic Internet Setup form is in the Internet Services folder
on the administrator’s Desktop.

This tab contains general information about the Internet
Services system setup.

Complete this form as follows:

Primary domain
name

Primary DNS

Postmaster name

Start Internet
Services
automatically

This is the domain name your server uses for
outgoing mail. The installer will attempt to
auto-configure this field for you. If no
domain name is defined, the IP address
assigned to the machine’s primary network
adapter will be used for most of the fields
requiring a domain name. You should,
therefore, check this field after installation
and change this if required.

This is the IP address of your DNS server. If
you use your ISP’s DNS, you’ll need to get
this IP address from them. If you have more
than one DNS machine available, you will
need to add those addresses on the
Advanced DNS form.

This is the name of the user responsible for
Internet Services. The default set by the
installer is “administrator”.

This is not supported by FirstClass on OS X.
See Installing FirstClass for details of how to
do this on OS X.

Use this tab to set up the Internet connection.

Complete this form as follows:

Internet connection This details the type of Internet connection

you have, either continuous or intermittent/
dialup. Select Continuous if you have a full-
time connection to the Internet.
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Forintermittentor This is used only if you have intermittent or

dialup connections  dialup connection to the Internet. Click
Routing to enable “Route through one
server”. Click Schedule to view or update
scheduling for this connection.

Mail tab On this tab you set basic Internet mail protocols. You only have
to do this if you want your users to receive Internet E-mail.

Complete this form as follows:

Enable SMTP This enables SMTP mail and is enabled by
default by the installer.

SMTP server domain This is the name or IP address of the

name computer that Internet Services is installed
on. This is auto-configured by the installer
and is required if SMTP is enabled.

Enable POP3 This enables your users to log in and retrieve
their E-mail using a POP3 mail client, like
Eudora, and is enabled by default by the
installer.

Enable IMAP4 This enables your users to log in using an
IMAP4 client, like Outlook Express, and
retrieve their E-mail and is enabled by
default by the installer.

Max outgoing mail  This sets the maximum number of
simultaneous outgoing messages and is set
by the installer to a default of 5. This number
is large enough to maintain significant mail
flow but not so large as to cause memory
problems.

Mail server This field only needs to be filled in if all your
users are going to be retrieving POP3 mail
from the same mail server. The installer
leaves this blank by default.

Advanced This allows you to view or update advanced
mail settings. Normally, you will not have to
change these settings.

News tab On this tab you set up the news protocol. You only have to do
this if you want users to receive news groups.
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Complete this form as follows:

Enable NNTP This enables NNTP and is selected by the
installer by default.

NNTPserverdomain This identifies the news server domain

name name. The installer auto-configures this
field and you should check this and change
it if required.

NNTP feedserver ~ This is the name of the server that provides
your news feed. This field is left blank by the
installer. If you don’t maintain your own
news server, you will need to arrange with
your ISP which news groups they send to
you.

Advanced This allows you to view or update advanced
news settings. Normally, you will not have
to change these settings.

Web & FTP tab On this tab you set up the HTTP protocol (allowing people to
access your web site with their web browsers) and the FTP
protocol (allowing people to download files from your web site).

Complete this form as follows:

Enable HTTP This allows people to access your web site
with their web browsers and is enabled by
the installer by default.

HTTP server domain This identifies the HTTP server domain

name name. The installer auto-configures this
field and you should check this and change
it if required.

Enable FTP This allows people to download files from
your web site and is enabled by the installer
by default.

FTP serverdomain  This identifies the FTP server domain name.

name The installer auto-configures this field and
you should check this and change it if
required.

Multiple Sites This allows you to set up multiple web sites
on this server, or multiple languages on a
web site.
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Advanced This allows you to view or update advanced
web and FTP settings. Normally, you will not
have to change these settings.

Directory tab On this tab you enable Directory filtering to control the exposure
of users’ E-mail addresses through Finger or LDAP clients.

Complete this form as follows:

Enable Finger This provides Finger clients with access to
the FirstClass directory and is enabled by the
installer by default.

Enable LDAP This provides LDAP clients with access to the
FirstClass directory and is enabled by the
installer by default.

Advanced This allows you to view or update advanced
Directory settings. Configure automatic
aliases and inbound mail addressing on this
form.

UCE/Spam tab On this tab you control the problem of SPAM, or unsolicited
commercial E-mail (UCE), by controlling which messages your
site relays and accepts, and how it handles messages it accepts.

Complete this form as follows:

Relaying This allows you to disable all relaying,
including SMTP AUTH and trusted IPs and is
selected by the installer by default. You can
also allow all authenticated users to relay or
can select users with certain features to
relay.

Handling junk mail  This section gives you options for handling
junk mail entering your system and is left
blank by the installer by default.

Refusing This gives you the option of rejecting
connections connections from any IP address listed in
Filters and is selected by the installer by
default.
Service tab On this tab you specify additional Internet Services settings.
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Complete this form as follows:

Service account
Internet Services
priority

Internet sessions

Configure

This is the name of your Service account and
is auto-configured by the installer as
“Internet”.

This sets the priority of Internet Services
operations on this machine and is auto-
configured by the installer.

This sets the maximum number of incoming
Internet protocol connections that Internet
Services will accept. The installer sets a
default value of 10. Many sites will need to
increase this significantly. A value of roughly
two-thirds of the server’s network sessions is
reasonable. The server’s network sessions
are configured using FirstClass Tools. See
FirstClass Tools Reference in our online help
for more information.

This allows you to view or update the
settings for the Internet account.

Configuring the Internet gateway form

Most administrators will not need to configure the Internet
gateway form. You only need to configure this form if your site
will use gateways. The Internet gateway form is in the Gateways
folder on the administrator’s Desktop.

Main tab On this tab you enter general information about your account
and Directory synchronization. In order for the gateway to
connect to the server, the name entered in “Service name” must
match the gateway name entered in “Service name” on the
Service tab of the Basic Internet Setup form. See our online help
for more information.

Note In a clustered Internet Services environment, you
will have multiple instances of this form each with
a different configuration as per your service. See
our online help for more information.
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Directory tab
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Use this button to set the Internet Services gateway password for
Directory services to work properly. By default, the password is
blank. For security reasons, we recommend you enter a
password immediately.

Note The password you set on the Internet gateway form
must be the same as the one set in the inetsvcs.fc
settings file. See our online help for more
information.

Use this tab to configure the Internet Services connection
schedule.

The Time A and Time B tabs control incoming E-mail (POP3),
news (NNTP), and dial-up connectivity. The Demand tab
controls when the service will connect based on the number of
incoming E-mail queued or when the user logs in (depending on
what you choose). For more information, see Internet Services
Administrator’s Guide and our online help.

Use this tab to list groups you want to be allowed to use this
service. Leaving this field blank makes the service unrestricted.

Configuring the inetsvcs.fc file

Internet Services and
FirstClass server on same
machine

Internet Services and
FirstClass server on
separate machines

If Internet Services is installed on the same machine as the
FirstClass server, you can connect with either the local machine
IP address of 127.0.0.1 (default), or with the specific domain
name or IP address for that machine. If this is your
configuration, you don’t need to modify the settings.

If Internet Services is installed on a different machine than the
FirstClass server, you must enter the domain name or IP address
of your server machine. This tells Internet Services where the
FirstClass server is, enabling communication between the
machines.

Configure the inetsvcs.fc file as follows:
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1. Copy /Library/FirstClass Server/inetsvcs.fc to the user’s
Library/FirstClass/Settings folder.

2. Open the FirstClass client login form.
3. Click Browse and browse to the inetsvcs.fc file.
4. Click Open to bring that information into the Login form.

5. If necessary, click Setup and configure the file to connect to
the FirstClass server.

Note The password used must match the gateway
password.

The file selection must match the file name
available in /Library/FirstClass Server/FCP.

6. Copy the configured inetsvcs.fc file and replace in /Library/
FirstClass Server/.
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Migrating FirstClass from Mac OS 9 to
Mac OS X

The process of migrating from FirstClass on Mac OS 9 to
FirstClass on Mac OS X involves migrating an existing FirstClass
7.1 post office on Mac OS 9 to an existing FirstClass 7.1 system
on Mac OS X.

Preparing to migrate the FirstClass post office

Before you begin this process, therefore, you must complete
upgrades and preparations on your Mac OS 9 system.

To prepare your FirstClass system on Mac OS 9, you must:

 upgrade your existing FirstClass system on Mac OS 9 to
FirstClass version 7.1

For upgrade instructions, see FirstClass 7.1 Upgrade ReadMe.

 run a trash collection and ensure that there are no significant
trash collection issues

« use the FirstClass Tools application to run the volume
diagnostics and save the report as a text file

This will provide volume, license and configuration
information for future use as needed.

 back up the post office.

Migrating the FirstClass post office

The actual migration of the existing FirstClass post office from
Mac OS 9 to Mac OS X involves putting the post office content
in the correct location for the Mac OS X system, and then
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Mac 0S X post office
locations

converting the file names, permissions and ownership so that
the Mac OS X system can recognize the post office.

Under Mac OS 8 and 9, the primary post office is located under
“FirstClass Post Office”, in the root folder of the primary volume.
Under OS X, the primary post office must be located in an fcpo
folder, under /Library/FirstClass Server/Volumes/Master. The
FirstClass server identifies the primary volume by name.

Any secondary FirstClass post office volumes on Mac OS X must
also be located in the /Library/FirstClass Server/Volumes folder.
Secondary volume folders can have any name, each with their
own fcpo subfolders or other folders as required, and can be
browsed from the FirstClass administrator’s Desktop Volumes
list. To define a new FirstClass folder there, you can create an
empty folder and give it an arbitrary name.

Migrate the FirstClass post office as follows:

1. Ifyou have not already done so,
Install and configure the OS X version of FirstClass 7.1 on
your Mac OS X system.

For instructions, see the Installing FirstClass and
Configuring your system on Mac OS X chapters of this guide.

2. Double-click the Status of FirstClass Services icon on the
Finder Desktop to ensure that the FirstClass server is not
running. If necessary, use the other icons to stop the server
and/or Internet Services before proceeding.

3. Delete the default fcpo post office folder under /Library/
FirstClass Server/Volumes/Master/fcpo.

Note You can rename the default post office, but we
recommend you delete it. As a default post office, it
can easily be recreated if necessary by running the
server installer again.

4. Copy the master “FirstClass Post Office” from Mac OS 9 to
Mac OS X as /Library/FirstClass Server/Volumes/Master/
fcpo.
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5. Ifyou have secondary volumes,
Migrate the secondary volumes as follows:

a) For each existing secondary fcpo volume, create a folder
on Mac OS X, under
/Library/FirstClass Server/Volumes

Example:
/Library/FirstClass Server/Volumes/Volume 2

b) Copy the secondary post office folder trees to these
folders.

Note: You can create new (empty) volumes for FirstClass
by creating new folders under “/Library/FirstClass
Server/Volumes”, or by linking other existing
folders or volumes there.

Converting filenames,  Once the FirstClass post office files are physically in place, you

gﬁlr:‘e'r‘s‘d‘i‘:" and must ensure the file permissions and ownership are set correctly,
and convert file names to lowercase, by running the fcfixvol
command from a Terminal shell window:

1. Enter the following at fcadmin%:
cd “/Library/FirstC ass Server”

2. Enter the following at the next prompt:
./fcfixvol -c all all

If prompted for a password, enter the password for the user
fcadmin.

The process may take several minutes depending on the number
and size of the post office volumes. The terminal window will
display the name of each post office it has recognized and tell
you when it has finished setting the permissions and ownership
on each.

Checking the migrated FirstClass post office

After the migration process is complete, check to ensure the
migration was successful as follows:

1. Start the FirstClass server and Internet Services.
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2.

Check the status using the Status of FirstClass Services alias
on the Mac OS X desktop.

Open /Library/FirstClass Server/fcsd.log (the equivalent of
the “console to log” file on Mac OS 9), and review any issues
recorded.

Log into the FirstClass Mac OS X server through the client as
administrator.

Choose File > Open on the administrator’s Desktop and
open and check each of the objects in this menu to ensure
the contents are as expected.

If mirroring
Ensure mirroring is progressing.

Note Once the mirror is synchronized, you should set up
or practice your backup and restore strategies. On
Mac OS X, the fcfixvol utility must be used every
time you restore from backup or copy from another
volume. For more information, see Setting post
office file permissions and ownership using fcfixvol
in the Administrating FirstClass chapter of this
guide.
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Administrating FirstClass

Once your FirstClass system is installed and configured, there is
very little difference between running that system on Mac OS X
and running it on any other platform. That’s the nature, and the
beauty, of FirstClass. You will find most of the information you
will need to administrate your system on an ongoing basis in the
online help system. This chapter details some notable exceptions
to that rule, providing you with details about what is different
about administrating FirstClass in a Mac OS X environment.

Using FirstClass volumes

The FirstClass Volumes
list

The FirstClass server for Mac OS X introduces a new concept of
logical FirstClass volumes. The Mac OS X operating system
mounts volumes under a /Volumes path. The FirstClass server
could use this list directly, however that would remove the
flexibility of allowing you to control what volumes are visible to
FirstClass administrators who have access to the Volumes list.
This is important not only for security reasons, but also for
performance reasons. It is important for you to be able to insert
CDs and DVDs or mount network volumes without having these
appear automatically to the FirstClass server.

The FirstClass server therefore allows you to define an explicit
list of volumes accessible to the server. These need not
correspond directly to physical drives, but could also be folders
or symbolic links to any location visible in the Mac OS X file
system hierarchy. For this reason, they are referred to as logical
volumes.

Note Although logical FirstClass volumes can be symbolic
links to any location, the fcpo (FirstClass post
office) folder in each volume and the files contained
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Uses of logical volumes

within that folder must be normal folders and files
rather than symbolic links.

Logical FirstClass volumes are stored within the FirstClass
Server folder under /Library, in a subfolder called Volumes. Any
folder (or symbolic link to a folder) in this Volumes folder is
considered to be a logical FirstClass volume, and will show up in
the FirstClass Volumes list on the administrator’s Desktop. An
additional entry corresponding to the root of the Mac OS X file
system will automatically appear in the FirstClass Volumes list.

In addition to being able to refer to multiple specific physical
drives from FirstClass, logical FirstClass volumes can be used to
partition users and/or conferences into logical groups, such as a
separate logical volume for Internet news groups, that can later
be split into separate physical devices. To do this physical split
at a later date, you would move the files to the desired location
and replace the FirstClass folder with a link to the other location
in the file system.

Logical volumes also allow multiple former Mac OS server
volumes to be merged onto one or more physical drives. To do
this, put the post offices in separate folders under the Volumes
folder.

And finally, they also leverage one of the greatest strengths of
UNIX-based systems, the logical union of different objects under
the single umbrella known as the root file system. Defining a
FirstClass volume as either a folder in the file system or a link to
an arbitrary location in the root file system allows for maximum
flexibility.

Setting post office file permissions and ownership using

fcfixvol

Any time you copy a post office from one volume to another or
restore from a backup, you must afterward use the fcfixvol utility
to set the permissions on the files and folders in the post office.

Use fefixvol as follows:
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1. Choose Go > Applications.
2. Double-click the Terminal application in the Utilities folder.

3. Enter the following at fcadmin%:
cd “/Library/Firstd ass Server”

4. Enter the following at the next prompt:
./ fcfixvol <volune > <fcpo>

Note To apply to all volumes, or all post offices on a
volume, substitute “all” for either parameter. For
example, to apply this command to all post offices
on all volumes, use:

/fefixvol all all

Other examples:

./fcfixvol Master all
./fcfixvol Master fcpo8001

Running fcfixvol with a missing argument displays
all possible values for that argument on that
FirstClass system.

The process may take several minutes depending on the number
and size of the post office volumes. The terminal will display the
name of each post office it has recognized and tell you when it
has finished setting the permissions and ownership on each.

Collecting activity statistics

FirstClass lets you collect daily server and Internet statistics on
selected user activities. This can help you see how users are
using their FirstClass environment and may also help when
troubleshooting an ongoing system problem.

Information about the types of statistics you can track, how to
specify which statistics you want to track and how to view user
statistics files is available in our online help.
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For FirstClass on Mac OS X, the statistics folder path you set
when completing the Statistics Control form must be an
fcadmin/admin writable directory. The recommended path is
/Library/FirstClass Server/Stats.

After creating such a folder, configure this path in the server as
follows:

1. Open the Reports folder on the administrator’s Desktop.
2. Double-click the Statistics Control form.

3. Type /Library/FirstClass Server/Stats in the Statistics folder
path.
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Appendix -

FirstClass File Locations on Mac OS X

It is recommended that you review and understand the
ownership, nature, and location of the FirstClass files and
folders (directories) on Mac OS X. While familiarizing yourself
with the FirstClass server for OS X, you may find it convenient
to print this information and post it next to the server computer
for reference.

fcadmin is the OS X user who executes and manages the
FirstClass server, Internet Services and FirstClass Tools. The
fcadmin user belongs to the OS X admin group and owns all of
the files.

The FirstClass server (named fcsd) runs as a full-fledged UNIX
daemon (service), while Internet Services (fcisd) executes in the
background as an application. Both are launched in the
background automatically at operating system startup time, if
you selected that option during installation, and neither requires
a user login.

Several root directories (those that start with “/”) are hidden
from the Finder. You must use the Finder’s Go > Go to menu
command, or Command+ Shift+G, or the Terminal utility, to see
folders such as /usr and /Volumes.

Locations:

e /Library/FirstC ass Server/
all executable-related files for both fesd and fcisd

e /Library/FirstC ass Server/fcfixvol
a FirstClass fcpo utility to set file permissions and ownership
and to convert file names to lowercase. May be executed at
any time.
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/Library/FirstC ass Server/fcisd.|log
/Library/FirstC ass Server/fcisd.old
current and prior Internet Services logs since launch, if IS
installed on the computer

e /Library/FirstC ass Server/fcp
the fcp files that inetsvces.fc uses to establish a connection to
the server

e /Library/FirstC ass Server/fcsd. | og
/Library/FirstC ass Server/fcsd. ol d
current and prior server logs since launch. Equivalent to
legacy console to log.

e /Library/FirstC ass Server/inetsvcs.fc
Internet Services settings file, if IS installed on the computer

e /Library/FirstCd ass Server/ Vol unes/ Mast er/
fcpo
the master logical volume

 /Library/FirstClass Server/Volumes/.../fcpo
a secondary logical volume if present

e /Library/Firstd ass Server/Volumes/.../
f cpo8001
the mirror logical volume if present

Any or all entries under /Library/FirstClass Server/Volumes/
may be links to other directories or volumes, but the actual fcpo
folders, and the folders underneath fcpo, cannot be symbolic
links.

Note Ensure fcfixvol utility is run at least once on all
logical FirstClass volumes before the server is
launched.

e /Library/Startupltens/FirstC ass |nternet
Servi ces
installed if IS auto launch selected during installation. This
folder can be deleted to stop Internet Services from being
auto-started at system startup time.

e /Library/Startupltens/FirstC ass Server
installed if server auto launch selected during installation.
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This folder can be deleted to stop the core server from being
auto started at system startup time.

Li brary/ FirstC ass Server/ Stats

If desired, you must manually create this folder, as described
in Collecting activity statistics in the Administrating FirstClass
chapter of this guide.The above is the recommended path for
this folder. It is not created by default.

/usr/sbin/fcsctl

/usr/sbin/fcisctl

the server and Internet Services control scripts used from a
Terminal shell, by the desktop icons, and by the Startupltems
scripts. These are not normally visible from the Finder
desktop. Choose Go > Go to Folder (Command + Shift+G)
and enter / usr/ shi n to see these files.

Note: This folder also includes many OS X system files
that should not be modified or deleted.

/ Vol unes

lists all available OS X desktop-mounted volumes. Do not
confuse / Vol umes with / Li brary/ First C ass
Server/ Vol unes.
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